EE 2301 Circuit Analysis I

Laboratory Manual

Southern Polytechnic State University
Division of Engineering
Electrical Engineering
## Table of Contents

Introduction ...................................................................................................................... 1

Lab Exercise 1: Introduction of Simulation Software Using MathCAD ............... 3

Lab Exercise 2: Introduction of Simulation Software Using PSpice ............... 14

Lab Exercise 3: Introduction to NI ELVIS II ................................................................. 23

Lab Exercise 4: Constructing and Analyzing Series and Parallel DC Circuits 32

Lab Exercise 5: Designing DC Circuits to Specifications ................................ 37

Lab Exercise 6: Analysis, Simulation and Measurement of a Multi-node Circuit ........................................................................................................... 40

Lab Exercise 7: Maximum Power Transfer via Thévenin’s Analysis ............... 43

Lab Exercise 8: The Oscilloscope and the Function Generator ....................... 48

Lab Exercise 9: Transient RC Circuits ................................................................. 58

Lab Exercise 10: Phasors and Impedances .................................................. 64

Lab Exercise 11: Source-Free RL and RC Circuits ........................................ 71

Lab Exercise 12: Sinusoidal RLC Circuits ...................................................... 73

Appendix A - Sample Laboratory Report ................................................................. 75

Appendix B - Resistor Color Code Chart ............................................................... 83
Introduction

General

Circuit Analysis I covers DC analysis, transient analysis, AC analysis, and frequency response analysis. Our laboratory exercises begin with an introduction of simulation software to be used both in the labs and in lectures. Simulation software include: MathCAD and circuit simulation software PSpice. Lab exercises continue with resistive circuits and powerful analysis techniques, such as nodal analysis, mesh analysis, superposition, source transformation, Thévenin’s theorem, Norton’s theorem, and several methods for simplifying networks of components connected in series or parallel.

The labs reinforce and augment the material covered in lecture, but will not necessarily be coordinated with the course. Sometimes the material covered in lecture will occur prior to the lab exercise, and sometimes the lab exercise will occur prior to the lecture. Both of these presentation orders are useful.

Lab attendance is mandatory and the lab is 25% of the course grade. There are NO MAKE-UPS for any missed labs. Generally, the lab instructor will go over some of the theory related to the lab and will highlight some aspects of the lab procedures in a brief lecture prior to the lab. You should listen carefully to this presentation and follow all instructions given. Each lab exercise should be read prior to attending lab and the pre-lab assignment should be completed and turned in at the start of each lab for pre-lab credit.

The student is responsible for bringing his or her protoboard and parts for each lab. The lab instructor does not provide parts and protoboards for students to complete lab exercises.

The Lab Report

Lab reports will not be accepted, nor graded, from a student who was absent for the lab exercise. Lab reports are individual assignments and should not be duplicated. In the event of duplicate reports, all reports involved receive a grade of 0 and no make-up allowed. The lab reports are formal lab reports. Lab reports should have a cover sheet, table of contents and the following sections: 1. Description, 2. Measurements, 3. Calculations, 4. Simulations, 5. Conclusion and Appendix with any supporting data. Lab reports should include tabulated data, graphs and screen shots from lab equipment and simulations. A sample report is available in GaVIEW Vista(WebCT). Lab reports are due the following week. Late reports will receive a deduction of 11 points per day. Incomplete or late pre-lab assignments will receive a deduction of 11 points.
Error, Percentage Error and Percentage Difference

Errors arise from a variety of factors and the meaning of the word “error” is somewhat variable. All data and all calculated results contain error in the sense of “uncertainty”. Instruments used to make the measurements are limited in both precision and accuracy. Another source of error is human error. This type of error may result from incorrect use of a measuring instrument due to lack of attention to instructions and detail.

One type of results-oriented error analysis that is done is comparison to a standard. The standard may be a prediction from theory. A “percentage error” calculation is performed as:

\[
\% \text{ error} = \frac{|\text{Standard Value} - \text{Experimental Value}|}{\text{Standard Value}} \times 100\% \quad \text{Equation 1}
\]

A comparison of two values may be required called the “percentage difference” or “relative difference”. This calculation is performed as:

\[
\% \text{ difference} = \frac{|\text{Value 1} - \text{Value 2}|}{\text{Average Value}} \times 100\% \quad \text{Equation 2}
\]
Lab Exercise 1. Introduction of Simulation Software Using MathCAD

Overview and Introduction:
This laboratory experiment introduces a simulation programming environments which are routinely employed in electrical engineering. MathCAD serves as a computational engine for challenging problems. MATLAB is another program with similar results; however SPSU has a site license for MathCAD and there is a free 30 day trial version located at http://www.Mathcad.com. (It is located under “Support” and then “Software Downloads” or click link of: http://www.ptc.com/appserver/wcms/forms/index.jsp?im_dbkey=41685&icg_dbkey=482)

The Mathsoft Apps MathCAD programming environment will be explored experimentally by means of completing some simple exercises. Basic features of the PSpice circuit simulation program with the schematic capture front end (Schematics) will be explored using simple resistive circuit examples.

Pre-Lab Assignment:
Use MathCAD to demonstrate basic math operations by adding, subtracting, multiplying and dividing any two numbers. Type your name and the date in the MathCad window. Print the results and turn-in as the pre-lab assignment at the start of lab, to demonstrate that you have used MathCAD prior to lab.

MathCAD Procedure:
1. Turn on the computer and allow it to boot into a Windows operating system, preferably Windows 7. If using a computer on campus, Log in as your user name and password or as “student” as username and the password.
2. Start Mathcad by left-clicking Start→Programs→Mathsoft Apps→Mathcad.
3. To perform any mathematical calculation, simply click on the screen at any convenient point to establish a crosshair on the display (the location of the first entry). Then type in the mathematical operation as demonstrated in the below Figure 1.

Figure 1. Using Mathcad to perform a basic mathematical operation.
4. The instant the equal sign is selected, the result will appear, in this case 197.333. Multiplication is obtained as usual by using the asterisk (*) appearing at the top of the number 8 key. The division is set by the / key at the bottom right of the keyboard. The equal sign can be selected from the top right of the keyboard. Another option is to apply the sequence View→Toolbars→Calculator to obtain the Calculator palette in Figure 1. Then use the calculator to enter the entire expression and obtain the result using the left clicker of the mouse.

![Figure 1. Calculator Palette](image1.png)

Figure 2. Using the Result Format dialog box.

5. Note that the format of the three results for the same equation is different. Mathcad allows the result to be formatted by the user. To change the format, select the equation and choose Format→Result… to obtain the Result Format dialog box in Figure 2. Select the second equation and change the format of the result to Scientific with three decimal places using the settings as shown in the figure. Change the format of the third result to be Engineering with three decimal places.

6. As an example in which variables must be defined, the resistance of a 200-ft length of copper wire with a diameter of 0.01 in. will be determined. First, as shown in Figure 3, the variables for resistivity, length, and diameter must be defined. This is accomplished by first calling for the Greek palette through View→Toolbars→Greek and selecting the Greek letter rho (\( \rho \)) followed by a combined Shift-colon (Shift :) operation. A colon and an equal sign will appear, after which 10.37 is entered. For all calculations to follow, the value of \( \rho \) has been defined. A left click on the screen will then remove the rectangular enclosure and place the variable in memory.
7. Proceed in the same way to define the length $l$ and the diameter $d$. Next the diameter in millimeters is defined by multiplying the diameter in inches by 1000, and the area is defined by the diameter in millimeters squared.

Note the $m$ had to be defined to the left of the expression for $A$ and the variable $d$ was defined in the line above. The power of 2 was obtained by first selecting the superscript symbol (^) at the top of the number 6 on the keyboard and then entering the number 2 in the Mathcad bracket. Or you can simply type the letter $m$ and choose $x^2$ from the Calculator palette. In fact, all the operations of multiplication, division, etc., required to determine the resistance $R$ can be lifted from the Calculator palette.

8. The equation for the resistance $R$ is defined in terms of the variables, and the result is obtained. The true value of developing in the above sequence is the fact that you can place the program in memory and, when the need arises, call it up and change a variable or two – the result will appear immediately. There is no need to reenter all the definitions – just change the numerical value.
9. Examples are a great way to practice Mathcad skills. Consider a simple circuit with three parallel resistive elements. The total equivalent resistance is 4 \( \Omega \) with 2 of the resistors being 10 \( \Omega \) and 20 \( \Omega \) respectively. The current dissipated by the first resistor is given as 4 amps. As shown in Figure 4, these known parameters and quantities of a network are entered first, followed by an equation for the unknown resistor \( R_3 \). (Incidentally, if you prefer to use subscripts, type the letter followed by a period and then the number as I and 1 look very alike.)

![Figure 4. Using Mathcad to confirm the results](image)

10. Note that after the first division operator was selected, a left bracket was established (to be followed eventually by a right enclosure bracket) to tell the computer that the mathematical operations in the denominator must be carried out first before the division into 1. In addition, each individual division into 1 is separated by brackets to ensure that the division operation is performed before each quantity is added to the neighboring factor. Finally, keep in mind that the Mathcad bracket must encompass each individual expression of the denominator before you place the right bracket in place.

11. Another way to confirm these results is to use the **Given Find** function. As shown in Figure 5, equations do not necessarily have to be manipulated to find the value of a particular variable. Here \( R_T, R_1, \) and \( R_2 \) are declared as before, but now \( R_3 \) is declared and assigned a guess (or initial) value of 1.
12. Next, as shown, the word **Given** must be entered to tell the computer that the defining equations will follow. Finally, each equation must be carefully entered using the Ctrl= operation instead of the regular equal sign. This produces the bold equal = of the defining equations. The results are obtained with the **Find(R3)** expression and an equal sign. As shown, the results are available with an acceptable degree of accuracy.

13. **Given Find** is a particularly straightforward way to solve simultaneous equations. As shown in Figure 6, a **Guess** value for each variable must first be defined. Such guessing helps the computer begin its iteration process as it searches for a solution. By providing a rough estimate of 1, the computer recognizes that the result will probably be a number with a magnitude less than 100 rather than have to worry about solutions that extend into the thousands or tens of thousands – the search has been narrowed considerably.
14. Next, as shown, the word *Given* is entered to tell the computer that the defining equations will follow. Finally, each equation must be carefully entered and set equal to the right side using the Ctrl= operation. The results are obtained with the `Find(I1,I2,I3)` expression and an equal sign. As shown, the results are available with an acceptable degree of accuracy even though entering the equations and performing the analysis took only a minute or two (with practice).

15. There is actually a quicker and more accurate way to solve simultaneous equations, but it involves using matrix algebra. The first step involves rewriting the system of equations in standard form. In standard form, all variables are to the left of the equal sign, only constants are on the right. In addition, the variables occur in the same order on the left side of each equation. The equations shown in Figure 6 are in standard form. *I*, *I*, and *I* appear, in the same order, in the left side of each and every equation. The right side of each equation contains only constants.

![Mathcad expression with variables and equations]

**Figure 6. Using the Given Find function to verify the results of another example**
16. With the equations in standard form, the solution is found using Mathcad as shown in Figure 7. To display the Matrix palette apply the sequence View → Toolbars → Matrix. Create a 3 by 3 matrix by clicking the matrix button in the upper left of the palette. In the dialog box select 3 rows and 3 columns and click okay. The values in the matrix are the coefficients of $I_1$, $I_2$, and $I_3$ as given by the equations in Figure 6. Once these values are entered raise the matrix to the -1 value by selecting the superscript symbol (^) at the top of the number 6 on the keyboard and then entering the number -1.

17. Next create the column vector by again selecting the matrix button from the Matrix palette. This time choose 3 rows and 1 column and click okay in the dialog box. Enter the values 15, 0, 0 in the column vector. Solve the system of equations by pressing the equal sign. Note the answers here are the same as they are in Figure 6.
18. Mathcad can be used to generate plots. First the concept of ranging variables and functions must be introduced. In Figure 8 the variable $V$ starts at 0 and goes to 30 in steps of 5. This is created in Mathcad by entering the variable name $V$, selecting Shift :, entering the first value of $V$ (0), entering a comma, entering the second value of $V$ (5), pressing the semicolon (;) key to create the range symbol (..), and finally entering the last value of $V$ (30). Note that the range symbol (..) is NOT inserted by pressing the period key twice.

19. Next $R_1$ and $R_2$ are declared as 1 and 10. The function $I_1(V)$ is created as $V / R_1$. $I_2(V)$ is created in a similar manner. To generate the plot, click below the declarations of $I_1(V)$ and $I_2(V)$. Select Insert → Graphs → XY Plots to generate a plot. Enter $V$ along the x-axis and $I_1(V)$, followed by a comma, and $I_2(V)$ along the y-axis. Hit the enter button and the plot will be displayed. Mathcad automatically scales the plots. Change the range of the y-axis to run from 0 to 7 by clicking on the values in the plot. To change other plot parameters, double-click on the plot, select the appropriate tab in the dialog box, and change the parameter. For example, change the plot to display grid lines.
20. Finally, a few more plots will be generated using Mathcad. In Figure 9 the variable $t$ starts at 0 and goes to 2 in steps of 0.001. Again, this is created in Mathcad by entering the variable name $t$, selecting **Shift :**, entering the first value of $t$ (0), entering a comma, entering the second value of $t$ (0.001), pressing the semicolon (;) key to create the range symbol (..), and finally entering the last value of $t$ (2). Remember that the range symbol (..) is **not** inserted by pressing the period key twice.

![Mathcad screenshot](image)

**Figure 9. Plotting a simple signal using Mathcad.**

21. Next the function $m(t)$ is created as the $2 + \sin(2\pi fm t)$ where $fm$ is a frequency of 1 Hertz. To generate the plot, click below the declarations of $fm$ and $m(t)$. Select **Insert→Graphs→XY Plots** to generate a plot. Enter $t$ along the x-axis and $m(t)$ along the y-axis. Hit the enter button and the plot will be displayed. Mathcad automatically scales the plots. Change the color of the plot trace (Trace 1) from red to blue.

22. Now repeat step 20 to create the carrier $c(t)$ is created as $\sin(2\pi fc t)$ where $fc$ is a frequency of 10 Hertz. The result should look like Figure 10.
Finally, let’s see what an amplitude modulated (AM) carrier looks like. Again, \(c(t)\) will be the carrier signal and \(m(t)\) will be the modulating signal. For example, \(m(t)\) might be the voice signal of a radio announcer and \(c(t)\) would be the AM station operating frequency such as 640 KHz. Amplitude modulation is accomplished by multiplying the carrier signal by the modulating signal, \(s(t) = m(t) * c(t)\). \(s(t)\) is declared as shown in Figure 11 and a final plot is generated. To display both the modulated carrier \(s(t)\) and the modulating signal \(m(t)\) for the y-axis first enter \(s(t)\). Then press the comma button and enter \(m(t)\). Pressing the enter button at this point generates a plot with two traces.

**Figure 10.** Plotting a carrier signal using Mathcad.
Figure 11. Plotting an amplitude modulated carrier signal using Mathcad.

24. Save your Mathcad work to be included in your lab report (see sample report). Convert the lab report to a pdf file and then upload it to WebCT to turn in to your instructor.
Lab Exercise 2: Introduction of Simulation Software Using PSpice

Overview and Introduction:

This laboratory experiment introduces a simulation programming environment which are routinely employed in electrical engineering. The PSpice circuit simulation program with the schematic capture front end is the free student version of the industry standard SPICE (Simulation Program With Integrated Circuit Emphasis). A free downloadable version can be found from OrCAD's website at http://www.cadence.com/products/orcad/pages/downloads.aspx or you can download here: http://www.spsu.edu/ee/lcrimm/PSpice91.exe

Pre-Lab Assignment:

Use PSpice to simulate the voltage divider circuit in Appendix 4, page 818, Figure A4.6 of the textbook. Type your name and the date in the PSpice window. Print the simulation results and turn-in as the pre-lab assignment at the start of lab, to demonstrate that you have successfully used PSpice prior to lab.

PSpice Procedure:

1. Start PSpice/Schematics by left-clicking Start→Programs→PSpice Student→Schematics. A blank schematic page should appear.

   Schematics is a front-end program with a direct interface to other PSpice programs and options. Using Schematics it is possible to design, draw and simulate circuits. Simulation results can be analyzed using the PSpice waveform viewer (Probe).

   Create the DC Series Circuit shown below on your schematic workspace by performing steps 3 through 13.

Note: for the remainder of the steps in this lab exercise, the term “click” will be used to specify left-clicking the mouse and the term “right-click” will be used to specify right-clicking the mouse.
2. Create the DC voltage source, V1, by doing the following:

Click **Draw** from the Schematics menu bar, to open the Draw drop-down menu, click **Get New Part**... to open the Part Browser Basic dialog box. In the Part Browser Basic dialog box, scroll the Full List box until the **VDC** option appears. Click on the **VDC** option. Click the **Place&Close** command button.

For the remainder of the steps in this lab, this sequence of procedures will be abbreviated as: Click **Draw→Get New Part→VDC→Place&Close**.

Position the DC voltage source in the left center of the schematic workspace by moving the mouse. Click to place the DC voltage source. Right-click to stop placing DC voltage sources. Note that the two step procedure **Draw→Get New Part** can also be executed by simply clicking the “Get New Part” icon which is located on toolbar above the schematic workspace.

3. In order to appropriately define the DC voltage source, V1, double-click on its schematic symbol. In the dialog box that opens, double-click on the **DC=** option of the list box, type "40V" (and remove “0V”) inside the **Value** text box, click the **Save Attr** command button. Next, click the **OK** command button.

4. Create the resistor, R1, by doing the following: Click **Draw→Get New Part→r→Place&Close**. Appropriately position the resistor by moving the mouse. Click to place the resistor. Right-click to stop placing resistors.

5. In order to appropriately define the resistor, R1, double-click on its schematic symbol. In the dialog box that opens, double-click on the **VALUE=** option of the list box, type "1500" (and remove “1k”) inside the **Value** text box, click the **Save Attr** command button. Next, click the **OK** command button.
6. Create the resistor, R2, by doing the following: Click **Draw→Get New Part→**r→**Place&Close**. Hold down the “Ctrl” key of the keyboard and press the “R” key of the keyboard simultaneously (this control key sequence will be specified as: Ctrl-R in future procedures). Note that this procedure causes the resistor, R2, to rotate counter-clockwise by 90 degrees. Appropriately position the resistor by moving the mouse. Click to place the resistor. Right-click to stop placing resistors.

7. In order to appropriately define the resistor, R2, double-click on its schematic symbol. In the dialog box that opens, double-click on the **VALUE=** option of the list box, type "500" (and remove “1k”) inside the Value text box, click the **Save Attr** command button. Next, click the **OK** command button.

8. Create the two ground symbols by doing the following: Click **Draw→Get New Part→EGND→**Place&Close. Appropriately position the first ground symbol by moving the mouse. Click to place the first ground symbol. Appropriately position the second ground symbol by moving the mouse. Click to place the second ground symbol. Right-click to stop placing ground symbols.

9. Connect (wire) components V1, R1 and R2 by doing the following: Click **Draw→Wire**. A pencil symbol will appear where the mouse pointer should be. Move the pencil so that it points at the top of the DC voltage source, V1. To start drawing a wire, click on the top of the DC voltage source and then move the pencil to point at the left terminal of the resistor, R1, and then click. Next, move the pencil so that it points at the right terminal of the resistor, R1. To start drawing a second wire, click on the right terminal of the resistor, R1, and then move the pencil to point at the top terminal of the resistor, R2, and then click. Right-click to stop drawing wires.

10. Create the output connection bubble by doing the following: Click **Draw→Get New Part→**BUBBLE→**Place&Close**. Press Ctrl-R three times to appropriately rotate the connection bubble. Properly position the connection bubble by moving the mouse. Click to place the bubble. Right-click to stop placing bubbles.

11. Label the connection bubble by doing the following: Double-click on the schematic symbol of the connection bubble. In the text box of the **Set Attribute Value** dialog box which is now open, type “Vout1” and then click the **OK** command button.

12. Create the text "DC Series Circuit" underneath the circuit by doing the following: Click **Draw** to open the **Draw** drop-down menu. From the open menu that appears, click **Text...**. In the **Add Text** dialog box that appears, type "DC Series Circuit" inside the **Text** box. Click **OK**. The outline of a box should now appear at the cursor. Move the cursor to the desired location below the circuit and click. The text is now placed. Right-click to stop placing text. Your circuit should now look similar to the **DC Series Circuit** shown on the first page of this lab exercise. Note that parts can be deleted from the circuit by clicking on the schematic symbol of the part (the symbol will be highlighted when the part is selected) and then pressing the “Delete” key on your keyboard. This technique is useful when you are trying to modify or correct a circuit.
13. To the right of the *DC Series Circuit* that was just completed, create the *DC Parallel Circuit* shown below.

![Figure 2. A DC parallel circuit.](image)

Use the applicable techniques that were performed in steps 3 through 13 as a guide to create and define the *DC Parallel Circuit*. Note that the value of the DC voltage source, V2, is 120V. The value of the resistor, R3, is 40, and the value of the resistor, R4, is 30. Be sure to create the appropriate text below the circuit.

14. To the right of the *DC Parallel Circuit* that you just completed, create the *AC Series Circuit* shown below.

![Figure 3. An AC series circuit.](image)

15. Create the sinusoidal AC voltage source, V3, by doing the following: Click **Draw→Get New Part→VSIN→Place&Close**. Appropriately position the sinusoidal AC voltage source. Click to place the sinusoidal AC voltage source. Right-click to stop placing sinusoidal AC voltage sources.
16. In order to appropriately define the sinusoidal AC voltage source, V3, double-click on its schematic symbol. In the dialog box that opens, double-click on the DC= option of the list box, type "0" inside the Value text box, click the Save Attr command button. Next, double-click on the AC= option of the list box, type "2.828" inside the Value text box, click the Save Attr command button. Next, double-click on the VOFF= option of the list box, type "0" inside the Value text box, click the Save Attr command button. Next, double-click on the VAMPL= option of the list box, type "4" inside the Value text box, click the Save Attr command button. Next, double-click on the FREQ= option of the list box, type "5" inside the Value text box, click the Save Attr command button. Finally, click the OK command button. This procedure defines the AC voltage source, V3, as a 4 V peak (2.828 V rms), 5 Hz sinusoidal waveform.

17. Use the applicable techniques that were performed in steps 3 through 13 as a guide to create and define the remaining portion of the AC Series Circuit. Note that the wire between V3 and R5 must be labeled as Vin. Double-click on the wire between V3 and R5. In the text box of the Set Attribute Value dialog box which is now open, type “Vin” and then click the OK command button. Use a similar approach to label the wire between R5 and R6 as Vout. Note that the value of the resistor, R5, is 22k, and the value of the resistor, R6, is also 22k. Be sure to create the appropriate text underneath the circuit. Also create the text “4Vp/5Hz” and locate it adjacent to the sinusoidal AC voltage source, V3.

18. When the three circuits are completed, save your overall schematic as “EE 2301_Lab1”.

19. You are now ready to set up a DC analysis for your schematic. Set up the DC analysis as follows. Click Analysis from the Schematics menu bar. From the open menu that appears, click the Setup… command. In the Analysis Setup dialog box that appears, click the DC Sweep… button. A DC Sweep dialog box should appear. Complete the DC Sweep dialog box as shown below:
When you are finished click **OK**. Then click the **Close** button in the *Analysis Setup* dialog box.

20. Click **Markers**→**Mark Current into Pin**. Position the tip of the marker on the left terminal of R1 by moving the mouse. Click to place the marker. Right-click to stop placing markers. Procedures **20** and **21** will allow a DC analysis to be performed. The DC voltages and currents for each component in all three circuits will be evaluated. In addition a graph of I(R1) versus V1 will be plotted (as V1 is varied from 0 V to 40 V in 1 V increments) in the PSpice waveform viewer (Probe).

21. To start the simulation, click **Analysis** from the *Schematics* menu bar. From the open menu that appears, click the **Simulate** command. When a successful simulation is finished the PSpice waveform viewer (Probe) should display a graph similar to the *Graph of I(R1) [in milliamperes] versus V1 [in volts]* shown on the next page.

   a. Note that as V1 increases, I(R1) increases.
   b. Observe that the graph is linear.
   c. Since Ohm’s law states that $V = I \times R$, then the slope of the graph is equal to $1/R$ (where $R$ is the total resistance of the circuit).
Figure 4. Graph of I(R1) in milliamperes versus V1 in volts.

When you are finished analyzing the graph, close the PSpice waveform viewer by clicking the Close button in the uppermost right-hand corner of the screen. This should return you to the Schematic screen.

22. Click the “Enable Bias Voltage Display” icon which is located on the toolbar above the schematic workspace (it is the icon button with a large “V” label). Note that this causes the DC (or average) voltage of each node in all three circuits to be displayed. If you click inside the box that is displaying the voltage, you can see the node to which it is associated.

a. Observe that the voltage divider rule is verified in the DC Series Circuit.
b. Observe that each resistor has the same voltage in the DC Parallel Circuit.
c. Note that the DC (or average) voltage of each node in the AC Series Circuit is zero.

When you are finished analyzing the DC voltage display, disable the DC voltage display by clicking the “Enable Bias Voltage Display” icon again.

23. Click the “Enable Bias Current Display” icon that is located on the toolbar above the schematic workspace (it is the icon button with a large “I” label). Note that this causes the DC (or average) current through each component in all three circuits to be displayed. If you click inside the box that is displaying the current, you can see the component (and direction) to which it is associated.
a. Observe that the current through each component in the *DC Series Circuit* is the same.
b. Observe that *Kirchhoff’s current law* is verified in the *DC Parallel Circuit*.
c. Note that the DC (or average) current through each component in the *AC Series Circuit* is zero.

When you are finished analyzing the DC current display, disable the DC current display by clicking the “Enable Bias Current Display” icon again.

24. Click the current marker that is located on the left terminal of R1. Note that the current marker is now highlighted. Press the “Delete” key on the keyboard to remove current marker.

25. You are now ready to set up a Transient analysis for your schematic. Set up the Transient analysis as follows. Click **Analysis** from the **Schematics** menu bar. From the open menu that appears, click the **Setup…** command. In the **Analysis Setup** dialog box that appears, click the **Transient…** button. A **Transient** dialog box should appear. Complete the **Transient** dialog box as shown below:

![Transient analysis dialog box](image)

When you are finished click **OK**. In the **Analysis Setup** dialog box, uncheck the **Enable** box located to the left of the **DC Sweep…** button. Then click the **Close** button in the **Analysis Setup** dialog box.

26. Click **Markers→Mark Voltage/Level**. Position the tip of the marker to touch the wire labeled *Vin* by moving the mouse. Click to place the marker. Position the tip of a second marker to touch the wire labeled *Vout* by moving the mouse. Click to place the second marker. Right-click to stop placing markers.
Procedures 26 and 27 will allow a transient analysis to be performed. An accurate plot of voltage versus time (in seconds) will result in the PSpice waveform viewer (Probe). In this specific transient analysis, $V_{in}$ and $V_{out}$ will be plotted versus time (for a duration of 1 second).

27. To start the simulation, click **Analysis** from the **Schematics** menu bar. From the open menu that appears, click the **Simulate** command. When the simulation is finished the PSpice waveform viewer (Probe) should display a plot similar to the following:

![Figure 6. Plot of Vin and Vout in volts versus time in seconds.](image)

a. Note that $V_{in}$ is a 4 V peak, 5 Hz sinusoidal AC waveform as expected.

b. Observe that 5 cycles (repetitions) of $V_{in}$ occur during 1 second.

c. Note that due to the **voltage divider rule**, $V_{out}$ is half the peak amplitude of $V_{in}$.

28. Time permitting, try some of the following:

a. Experiment with the **cursors** in the PSpice waveform viewer.

b. See if you can set $V_{in}$ to a 10 V peak, 2 Hz waveform and if you can display the modified $V_{in}$ waveform in the PSpice waveform viewer.

c. Change the value of some components in the DC circuits and note how the results of the simulation change.

d. Use the **select** and **copy** features to create a fourth circuit.

29. Save your PSpice work to be included in your lab report (see sample report). Convert the lab report to a pdf file and then upload it to WebCT to turn in to your instructor.
Lab Exercise 3: Introduction to NI ELVIS II

Introduction:

The NI ELVIS II environment consists of the following components:

Hardware workspace for building circuits and interfacing experiments. NI ELVIS II software (created in NI LabVIEW software), which includes the following:

- Soft Front Panel (SFP) instruments
- LabVIEW Application Programmatic Interface (API)
- Multisim Application Programmatic Interface (API)

With the APIs, you can achieve custom control of and access to NI ELVIS II workstation features using LabVIEW programs and simulation programs written within Multisim.

This lab introduces NI ELVIS II by showing how you can use the workstation to measure electronic component properties. Then you can build circuits on the protoboard and later analyze them with the NI ELVIS II suite of SFP instruments.

Figure 1. NI ELVIS II Worstation
Objectives:

1. Apply Kirchhoff’s Laws and Ohm’s Law to determine resistor, voltage and current values for a simple voltage divider circuit given a particular source voltage and resistor specifications.
2. Apply voltage division to analyze the circuit.
3. Use PSpice to predict and determine the voltages and current in a simple voltage divider circuit.
4. Use a Digital Multimeter (DMM) to measure resistance, voltage, and current in the circuit.

Equipment:

NI ELVIS II workstation, computer with NI Elvis II interface software installed, PSpice installed, DC Power Supply, Digital Multimeter and test probes, protoboard, banana plug cables, assorted resistors, and jumper wire.

Pre-Lab Assignment:

1. Determine the resistor values based on the color codes of the resistors to be used for the voltage-divider circuit and record data.
2. Construct the voltage-divider circuit so that you will be ready to test and analyze while in the laboratory.
3. Use the schematic editor of PSpice to sketch each circuit in Figure 6, select “Simulate,” and then use the V and I buttons to find all V’s and I’s. Add a text box containing your name and date in the upper right corner prior to printing a hardcopy and submit results as your pre-lab assignment at the start of lab. Also, include these simulation results in the final lab report. Missing or late pre-lab assignments results in a 11 point deduction from the final lab report.

Lab Procedures:

1. Turn on and then login the computer with the NI ELVIS II interface software. Power up the NI ELVIS II board (switch on the back of the NI ELVIS board). The USB ACTIVE (orange) LED turns ON. In a moment, the ACTIVATE LED turns OFF and the USB READY (orange) LED turns ON.

2. On your computer screen, click on the NI ELVISmx Instrument Launcher Icon or shortcut in Figure 2. A strip of NI ELVIS II instruments appears on the screen shown in Figure 3. You are now ready to make measurements.
3. Connect two banana-type leads to the digital multimeter (DMM) inputs [V Ω ] and [COM] on the left side of the workstation, shown in Figure 4. Connect the other ends to one of the resistors.

4. Click on the DMM icon (Figure 3) within the NI ELVISmx Instrument Launcher to select the digital multimeter.

You can use the DMM SFP for a variety of operations such as voltage, current, resistance, and capacitance measurements. Use the notation DMM[X] to signify the X operation. The proper lead connections for this measurement are shown on the DMM front panel, Figure 5.
5. Click on the Ohm button [Ω] to use the digital ohmmeter function, DMM[Ω]. Click on the green arrow [Run] box to start the measurement acquisition. Measure the two resistors R1, and R2.

Record the following data based on resistor color codes and DMM reading:

R1 _______ (Brown – Black - Red )  
R2 _______ (Red – Red – Red )

To stop the acquisition, click on the red square [Stop] box.
Note If you click on the Mode box, you can change the {Auto} ranging to {Specify Range} and select the most appropriate range by clicking on the Range box.

6. Using the two resistors, R1 and R2, assemble the following circuit on the NI ELVIS II protoboard in Figures 6 and 7.

![Figure 6. Voltage Divider Circuit Schematic](image1)

![Figure 7. Voltage Divider Circuit Assembled on Protoboard](image2)
7. Connect the input voltage, \( V_s \), to the [+5 V] pin socket, Figure 8.

8. Connect the common to the [GROUND] pin socket, Figure 8.

9. Connect the external leads to the DMM voltage inputs [V Ω ] and [COM] on the side of the NI ELVIS workstation and the other ends across the R2 resistor, Figure 9.
10. Check the circuit and then apply power to the protoboard by pushing the prototyping board power switch to the upper position [–]. The three power indicator LEDs, +15 V, –15 V, and +5 V, should now be lit and green in color, Figure 10.

![Figure 10. Power LED Indicators on NI ELVIS II protoboard.](image)

**Note** If any of these LEDs are yellow while the others are green, the resettable fuse for that power line has flipped off. To reset the fuse, turn off the power to the protoboard. Check your circuit for a short. Turn the power back on to the protoboard. The LED flipped should now be green.

11. Connect the DMM[V] test leads to Vs and measure the input voltage using the DMM[V] function. Press [Run] to acquire the voltage data.

Vs (measured) _______________

According to circuit theory, the output voltage, V2 across R2, is as follows:

\[
V_2 = \frac{R_2}{R_1 + R_2} V_s
\]

12. Using the previous measured values for R1, R2 and Vs, calculate V2.

Next, use the DMM[V] to measure the actual voltage V2.

V2 (calculated) _______________
V2 (measured) _______________

13. How well does the measured value match your calculated value?
According to Ohm’s law, the current ($I$) flowing in the above circuit is equal to $V_2/R_2$.

14. Using the measured values of $V_2$ and $R_2$, calculate this current.

15. Perform a direct current measurement by moving the external lead connected to $[\text{V}\Omega]$ to the current input socket (A), Figure 11. Connect the other ends to the circuit as shown below, Figures 12 and 13.

![Figure 11. DMM lead connected to the current input socket.](image)

![Figure 12. Schematic of circuit modification to measure current.](image)
16. Select the function DMM[A] and measure the current.

\[
I \text{ (calculated)} \quad \underline{\text{(measured)}}
\]

17. How well does the measured value match your calculated value?

18. Time permitting, repeat all measurements with **non-NI ELVIS equipment** to familiarize yourself with other measurement equipment and to validate previous measurements performed.

**Report Guidelines and Post Lab:**

Compare your experimental results to your theoretically expected values using relative difference calculations. Tabulate your relative differences to compare the measured values of current and voltage to the ones you determined in your pre-lab calculations, as well as the values obtained via PSPICE. Interpret your results, identifying sources of error as appropriate. Include the results of your work as a part of your lab report, comparing calculations based on theory, simulation results and measured results. After completing your final lab report, upload it as a single file (either .pdf or .doc) to GaView/WebCT by the report deadline.
Lab Exercise 4: Constructing and Analyzing Series and Parallel DC Circuits

Overview and Introduction:

During this lab you will use Ohm's Law to predict the voltages and current in a series and a parallel circuit. Resistor values will be found using the resistor's color code. After building the circuits a Digital Multimeter (DMM) will be used to measure resistance, voltage, and current in the circuit. These values will be compared to the calculated values acquired using Ohm's Law.

Equipment:

NI ELVIS II workstation, computer with NI Elvis II interface software installed, PSpice installed, DC Power Supply, Digital Multimeter and test probes, protoboard, banana plug cables, assorted resistors, and jumper wire.

Pre-Lab Assignment:

1. Based on the two circuits below in Figures 1 and 5, that vary each semester, determine the resulting value of the equivalent resistance $R_{eq}$ in conjunction with the given voltage source $V_s$. Use Ohm’s law to compute the total current for each circuit.

2. Apply Ohm’s law and other techniques to R1, R2, R3 and R4 of each circuit to calculate all voltage drops across the resistors and all currents flowing through the resistors.

3. Use the schematic editor of PSpice to sketch each circuit, select “Simulate,” and then use the V and I buttons to find all V’s and I’s. Be sure to both display and record your values. Add a text box containing your name and date in the upper right corner prior to uploading to GaVista and submitting these results as your pre-lab assignment at the start of lab. Also, include these simulation results in your lab report. Missing or late pre-lab assignments results in an 11 point deduction from the lab report grade.

4. Determine the values of the resistors to be used for both circuits and record in your work. This information will be useful in choosing the correct resistor when constructing the circuit.

   R1 _______ (Green-Blue-Brown)
   R2 _______ (Red-Red-Brown)
   R3 _______ (Orange-Orange-Brown)
   R4 _______ (Yellow-Violet-Brown)

   $V_s = 9 V$
5. **(Optional)** Construct the series and parallel circuit, using provided protoboard, so that you will be ready to test and analyze while in the laboratory.

**Lab Procedure:**

1. Leaving the power supply off and starting with the series circuit, use a DMM, using the one integrated into the NI ELVIS II workstation and a standalone DMM, measure the resistance of both R1 and R2 resistors in the circuit in Figures 1 and 2.

![Figure 1. Schematic of Series DC Circuit](image1)

![Figure 2. Series DC Circuit on NI Elvis Board](image2)
2. The DMM should be configured to measure DC voltage. Turn on the power supply by clicking the VPS button on the NI Elvis Instrument launcher and using the Supply + variable power supply controls shown in Figure 3. Construct the jumper wires for power to the circuit using rows 48 and 49 in Figure 4. Set the voltage to the source voltage $V_s$ volts specified in the pre-lab. Use the DMM to measure the voltage to verify $V_s$ is being supplied to the circuit.

![Figure 3. Variable Power Supply (VPS) Controls](image1)

![Figure 4. Variable Power Supply (+) and Ground – Rows 48 and 49](image2)

3. Connect the power supply to the circuit using the variable power supply (+) row 48 and the ground row (49), in Figure 4. Use the DMM to measure all the voltages in the circuit and record your data in an organized fashion.
4. Break the connection between the positive terminal of the power supply and resistor R1. Configure the DMM for measuring current by changing the red lead to the port marked with an A or mA. The black lead is unchanged. Now use the DMM to complete the circuit by connecting the red lead to the power supply and the black lead to the resistor. The DMM should provide an amperage reading. Be certain to properly record your data.

5. Repeat these steps for the parallel circuit while ensuring to measure the current for each branch of the circuit, Figures 5 and 6.

![Figure 5. Schematic of Parallel DC Circuit](image)

6. Time permitting, repeat all measurements with non-NI ELVIS equipment to validate previous measurements performed.
Report Guidelines and Post Lab Procedures:

Remember to include the following in your lab report: Calculations using Ohm's Law from the pre-lab, PSpice simulation of both circuits displaying voltages and currents, measurements acquired during lab, along with a theoretical discussion and conclusions. Compare your experimental results to your theoretically expected values (i.e measured and calculated values) using relative difference calculations. Interpret your results, identifying sources of error as appropriate.

Design Problem: Design a circuit using standard resistor values which would provide a 5 volt output given a tolerance of 5%.
Lab Exercise 5: Designing DC Circuits to Specifications

Overview and Introduction:

Using Kirchhoff’s Laws and Ohm’s Law you will select resistors for a series-parallel combination circuit that will provide the required voltages and current. Voltage division, current division, and resistor combination techniques will also be utilized.

Equipment:

NI ELVIS II workstation, computer with NI Elvis II interface software installed, PSpice installed, DC Power Supply, Digital Multimeter and test probes, protoboard, banana plug cables, assorted resistors, and jumper wire.

Pre-Lab Assignment:

1. Apply Kirchhoff’s Laws, Ohm’s Law, voltage and current division to determine and select resistor values for the circuit shown below in Figures 1 and 2, with $V_s=12\,\text{V}$, $V_{23}=1.99\,\text{V}$, $I_s=6.67\,\text{mA}$, $I_2=4.24\,\text{mA}$, and $I_3=2.43\,\text{mA}$.

2. Use PSpice to verify your results. Generate an I-V plot and using the slope of the graph, calculate the total resistance of the circuit. Make sure to record the resistor values used in the circuit design.

3. Build the circuit for testing in lab.

Lab Procedure:

1. Leaving the power supply off, construct the circuit in Figures 1 and 2. Use a DMM to measure the total equivalent resistance of the entire circuit. Make sure to record the resistor values used in the circuit design.

![Figure 1. Schematic of Series-Parallel Combination Circuit](image)
2. Prepare the DMM for measuring DC voltage. Set the power supply to the source voltage $V_s$ specified in the pre-lab, using the VPS – Variable Power Supply controls and NI Elvis board interface shown in Figures 3 and 4. Apply power to the circuit.
3. Use the DMM to measure all the voltages in the circuit. Record measured data.

4. Prepare the DMM to measure DC current. Measure each current being sure to break the connection and using the DMM to complete the circuit. Record measured data.

**Report Guidelines and Post Lab Procedures:**

Remember to include the following in your lab report: Calculations from the pre-lab, PSpice simulation of the circuit displaying voltages and currents, and measurements acquired during lab. Compare your experimental results to your theoretically expected values (i.e measured and calculated values) using relative difference calculations. Interpret your results, identifying sources of error as appropriate.

**Design Problem:** Design a similar circuit using standard resistor values which would provide a 10 volt output at 15 mA with a given a tolerance of 5%.
Lab Exercise 6: Analysis, Simulation and Measurement of a Multi-node Circuit

Overview and Introduction:

1. Apply Nodal and Mesh Analysis with appropriate characterizing equations for a multi-node circuit.
2. Use MathCAD, a TI-89 calculator or matrix calculations to demonstrate solving the simultaneous nodal and mesh equations.
3. Use PSpice to determine the nodal voltages and mesh current in a multi-node circuit.
4. Construct a multi-node circuit and use a Digital Multimeter (DMM) to measure its voltages and currents.

Equipment:

NI ELVIS II workstation, computer with NI Elvis II interface software installed, PSpice installed, DC Power Supply, Digital Multimeter and test probes, protoboard, banana plug cables, assorted resistors, and jumper wire.

Pre-Lab Assignment:

1. Based on the circuit shown in Figures 1 and 2, determine the resulting standard form nodal equations and mesh equations associated with solving the circuits’ unknown nodal voltages and mesh currents. Use MathCAD or a TI-89 (perhaps simulated) to solve for all of these unknown V1, V2, V3 and I1, I2, I3.

2. Select resistor values for the circuit in Figure 1 with the source voltage V_s = 8 V, and

   \begin{align*}
   R1 &= \underline{\text{Brown-Green-Red}} \\
   R2 &= \underline{\text{Gray-Red-Brown}} \\
   R3 &= \underline{\text{Red-Red-Brown}} \\
   R4 &= \underline{\text{Brown-Black-Orange}} \\
   R5 &= \underline{\text{Green-Blue-Brown}} \\
   R6 &= \underline{\text{Brown-Black-Red}}
   \end{align*}

3. Use the schematic editor of PSpice to sketch each circuit provided by your instructor, select “Simulate,” and then use the V and I buttons to find all V’s and I’s. Add a text box containing your name and date in the upper right corner prior to uploading results as your pre-lab in a pdf or word file. Be sure to record your values.

4. Determine resistor values based on the color codes of the resistors specified in step 2.

5. Construct the multi-node circuit so that you will be ready to test and analyze while in the laboratory.
**Lab Procedure:**

1. Leaving the power supply off, construct the circuit in Figures 1 and 2. Use a DMM to measure each resistor in the entire circuit.

2. Prepare the DMM for measuring DC voltage. Set the variable power supply to the source voltage $V_s$ specified in the pre-lab, using the VPS – Variable Power Supply controls and NI Elvis board interface shown in Figures 3 and 4, in the previous lab exercises. Apply power to the circuit.

3. Use the DMM to measure all the voltages in the circuit. Record measured data.

4. Prepare the DMM to measure DC current. Measure each current being sure to break the connection and using the DMM to complete the circuit. Record measured data.

![Figure 1. Schematic of the Multi-node Circuit](image.png)
Report Guidelines and Post Lab Procedures:

Remember to include the following in your lab report: Calculations from the pre-lab, PSpice simulation of the circuit displaying voltages and currents, and measurements acquired during lab. Compare your experimental results to your theoretically expected values (i.e measured and calculated values) using relative difference calculations. Interpret your results, identifying sources of error as appropriate.

Design Problem: Design a similar circuit with at least 3 meshes where each current doubles or halve from the previous mesh.
Lab Exercise 7: Maximum Power Transfer via Thévenin’s Analysis

Overview and Introduction:

1. The main objective of this laboratory exercise is to find the value of the load resistor $R_L$ in the circuit where the maximum power is delivered to the load using Thévenin’s analysis and superposition techniques in a circuit with more than one independent voltage source.

2. Use MathCAD or a TI-89 calculator (or equivalent) to demonstrate solving simultaneous or a system equations.

3. Use PSpice to predict and determine the voltages, current, and power dissipation in a multi-source circuit.

4. Construct a circuit and use a decade resistance box to determine the value of the load resistor $R_L$ where maximum power transfer occurs.

5. Compare the responses produced by the complex circuit versus its more simpler Thévenin equivalent.

Equipment:

NI ELVIS II workstation, computer with NI Elvis II interface software installed, PSpice installed, Digital Multimeter and test probes, protoboard, banana plug cables, assorted resistors, decade resistance box, and jumper wire.

Pre-Lab Assignment:

1. Based on the circuit schematic in Figures 1 and 2, apply superposition to determine the resulting Thévenin equivalent by calculating the $V_{OC}$, $I_{SC}$ and $R_{TH}$.

2. Use the schematic editor of PSpice to sketch the circuit, select “Simulate,” and then use the V and I buttons to find all V’s and I’s. Add a text box containing your name in the upper right corner, the Lab # and the date, prior to saving into a SINGLE pdf file as a part of your pre-lab. Be sure to record your values.

3. Construct the multi-source (note: 2 different DC independent voltage sources) circuit so that you will be ready to test and analyze while in the laboratory.
Lab Procedures:

1. Use a decade resistance box to vary the load resistance and prove where maximum power is transferred. Connect the decade resistance box to the NI Elvis system with the banana plug cables as shown in Figure 3. This particular connection accomplishes two functions: it creates a connection for $R_L$ in the circuit and provides for the measurement of current through $R_L$, without physically breaking $R_L$ each time, to measure the current.

2. Leaving power supplies off, use a DMM to measure each resistor of the entire circuit, including the resistor value of the decade resistance box which is $R_L$. Use a separate DMM for these measurements in this laboratory exercise.

3. Prepare the DMM for DC voltage measurements. Turn on two separate power supplies using both the NI Elvis VPS the 12 V power supply (as in previous labs) and the NI Elvis +5 V power supply (as in lab #3). Use the DMM to check the voltage sources output of 12 V and 5 V DC.

4. Set the decade resistance box to output $R_L = 0 \, \Omega$. This is an important data point. This is our short circuit condition shown in Figure 4 and provides important data that should agree with and validate our $I_{sc}$ calculations. Record all data and also complete the data in Table 1 to assist with determining $R_L$. Complete the data in Table 1 by varying $R_L$ until the $R_L$ value is determined experimentally, that reflects maximum power. The last value
of $R_L = 99,999 \, \Omega$ may simulate our open circuit shown in Figure 5, where $R_L = \infty \, \Omega$. This is another important data point, where we collect open circuit data, which should agree with and validate your $V_{OC}$ calculations. (Note: If $R_L$ can not be set high enough using the decade resistance box, physically create an open circuit on the circuit board by removing the jumper wire at the connection of the 470 $\Omega$ and 330 $\Omega$ resistors.)

5. Use the DMM to measure all the voltages in the circuit and be sure to record all data in an organized fashion.

6. **Remember** to break the connection when using the DMM to measure all currents, and then use the DMM leads connected in **series** to rejoin the circuit with correct polarity. Again, be certain to record data properly.

Figure 2. Multi-source Circuit on NI Elvis Board
Figure 3. Decade Resistance Box connections to the NI Elvis Board

Figure 4. Schematic illustrating a short circuit at the load (R = 0 Ω)
Figure 5. Schematic illustrating an open circuit at the load ($R = \infty \Omega$)

Table 1. Load voltage and load power for different values of $R_L$

<table>
<thead>
<tr>
<th>$R_L$ Decade Box ($\Omega$)</th>
<th>$R_L$ Measured ($\Omega$)</th>
<th>$V_L$ (V)</th>
<th>$I_L$ (mA)</th>
<th>$P_L$ (W)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short circuit 0</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>50</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>100</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>150</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>175</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>185</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>195</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>200</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>300</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open circuit Xxxxxx</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Report Guidelines and Post Lab Procedures:

Compare your experimental (measured) results to your theoretically (calculated) expected values using relative difference calculations. Tabulate your relative differences to compare the measured values of all $V$’s and $I$’s to the ones you determined in your pre-lab calculations, as well as the maximum power transfer data in Table 1. Interpret your results, identifying sources of error as appropriate. **Be sure to show a graph of the MPT experiment results.** Remember to include the following in your lab report: Calculations from the pre-lab, PSpice simulation of the circuit displaying voltages and currents, and measurements acquired during lab.
Lab Exercise 8: The Oscilloscope and the Function Generator

Overview and Introduction:
1. Use the NI Elvis Function Generator to produce a sinusoidal voltage for AC circuits.

2. Use the NI Elvis Oscilloscope to measure the amplitude and phase of sinusoidal signals for AC circuit analysis.

Equipment:
NI ELVIS II workstation, computer with NI Elvis II interface software installed including the NI Elvis Oscilloscope and Function Generator, PSpice installed, Digital Multimeter and test probes, protoboard, banana plug cables, assorted resistors, and jumper wire.

Pre-Lab Assignment:
1. Use the schematic editor of PSpice to sketch the circuits in Figures 1-4, select “Simulate,” and then use the V and I buttons to find all V’s and I’s. Add a text box containing your name in the upper right corner, the Lab # and the date, prior to saving into a SINGLE pdf file as a part of your pre-lab. Be sure to record your values.

2. For an AC voltage signal of: \(v(t) = 10 \sin t\), what are the following values (read the Preliminary section for more detailed information)?
   a. Amplitude ______
   b. Frequency ______
   c. Phase __________
   d. \(V_{p-p}\) __________
   e. \(V_p\) __________
   f. \(V_{rms}\) ________

3. Construct the three circuits so that you will be ready to test and analyze while in the laboratory in Figures 1-4, using the values below:

   \[
   \begin{align*}
   R1 &= 2.2 \, k\Omega \quad \text{Red – Red – Red} \\
   R2 &= 820 \, \Omega \quad \text{Grey – Red – Brown} \\
   C1 &= 0.082 \, \mu\text{F} \\
   L1 &= 4.7 \, \text{mH} \\
   V_s (\text{DC}) &= 10 \, \text{V} \\
   V_s (\text{AC}) &= 10 \, V_{p-p} \, @ \, 1 \, \text{kHz}
   \end{align*}
   \]
Figure 1. Schematic of the Series Circuit with a DC Source

Figure 2. Schematic of the Series RC Circuit with an AC Source

Figure 3. Schematic of the Series RL Circuit with an AC Source
Preliminary: Introduction to AC signals, sinusoids and AC voltage measurements

An AC signal is typically time-varying (not constant, as with DC signals). An AC signal has a specific shape, may be repetitive at a specific frequency, and it may be a delayed version of a similar waveform. Power supplies and digital multimeters are normally used to generate and test DC voltages, while function generator and oscilloscopes are frequently used to generate and test AC signals.

One of the most common types of AC signals is the sinusoid, which exhibits a sinusoidal variation of voltage with time (its voltage is proportional to the sine of t). Sinusoids are completely characterized by three parameters: amplitude, frequency and phase. Examples of
sinusoidal signals are pure audio tones and the AC power-line waveform. Sinusoids make good test signals and most other AC waveforms can be synthesized by adding sinusoids of different amplitudes and frequencies.

AC voltages can be specified in terms of **peak-to-peak (V_{p-p})**, **peak voltage (V_p)**, and **RMS voltage (V_{rms})**.

- $V_{p-p}$: Peak-to-peak voltage is the difference between the largest voltage and the smallest voltage associated with the waveform.
- $V_p$: Peak voltage is the difference between the waveform’s largest voltage and its average voltage.
- $V_{rms}$: RMS voltage (for sinusoid only) is 0.707 times the peak voltage.

**Measurements of AC signal:**

- **Amplitude** is a nonnegative scalar measure of a wave's maximum magnitude of oscillation. In electrical engineering it may be thought of as the maximum absolute value reached by a voltage or current waveform as measured from the center of the oscillation. An amplitude measurement may be reported as peak, peak-to-peak, average, or RMS.

- **Peak** amplitude is the height of an AC waveform as measured from the center of the oscillation to the highest positive or lowest negative point on a graph. Also known as the *crest* amplitude of a wave.

- **Peak-to-peak** amplitude is the total height of an AC waveform as measured from maximum positive to minimum negative peaks (the highest peak to the lowest valley) on a graph of the waveform. Often abbreviated as “P-P”, e.g., $V_{p-p}$ or $V_{pp}$.

- **Average** value is the arithmetic “mean” of a waveform’s values over one cycle. The average value of any waveform with equal-area portions above and below the “zero” line on a graph is zero. However, often as a practical measure of amplitude, a waveform may be characterized by its average absolute value, calculated as the arithmetic mean of the absolute values of the waveform.

- “RMS” stands for *Root Mean Square*, and is a way of expressing an AC quantity of voltage or current in terms functionally equivalent to DC. For example, 10 volts AC RMS is the amount of AC voltage that would produce the same amount of heat dissipation across a resistor of given value as a 10 volt DC power supply. Also known as the “equivalent” or “DC equivalent” value of an AC voltage or current.
• Analog, electromechanical meter movements respond proportionally to the average absolute value of an AC voltage or current. When RMS indication is desired, the meter's calibration must be adjusted accordingly, usually by applying a constant multiplicative factor assumed for a sinusoidal wave. This means that the accuracy of an electromechanical meter's RMS indication is dependent on the purity of the waveform and whether it is the same wave shape as the waveform used in calibrating.

Oscilloscopes are normally used to measure peak-to-peak voltage, while digital multimeters indicate rms voltage. To compare digital multimeter and oscilloscope measurements, you must first convert one of the values to the other measurement scheme (e.g. $V_{\text{rms}}$).

**Caution:** Most DMMs provide accurate AC measurements for sinusoidal signals only.

**Lab Procedures:**

*Function Generator and Oscilloscope:*

Use the NI Elvis instrument launcher to open the function generator and the oscilloscope shown in Figure 6.

![NI Elvis Instrument Launcher Scope & FGEN](image1)

**Figure 6. NI Elvis Instrument Launcher Scope & FGEN**

This will open the NI Elvis function generator and oscilloscope shown in Figure 7.

![NI Elvis Function Generator and Oscilloscope](image2)

**Figure 7. NI Elvis Function Generator and Oscilloscope**
The function generator settings are highlighted in Figure 7 and should be set to the following:

- Signal Route: **FGEN BNC**
- Waveform setting: **Sinusoid**
- Frequency: **1 kHz**
- Amplitude: **10 Vpp**

The oscilloscope settings are highlighted in Figure 8 and should be set to the following:

- Display Measurements: **CH0 and CH1 checked**
- Channels 0 and 1 Settings: **Enables checked**
- Scale Volts/Division: **2 V**
- Vertical Position: **0**
- Time/Division: **200 μs**

![Oscilloscope Settings for both Channels 0 and 1](image)

**Figure 8. Oscilloscope Settings for both Channels 0 and 1**

The digital storage oscilloscope (DSO) is now the preferred type of oscilloscope for most industrial applications, although analog oscilloscopes are still widely used. The DSO uses
Digital memory to store data as long as required without degradation. The digital storage allows use of an enormous array of sophisticated digital signal processing tools for the analysis of complex waveforms in today’s circuitry.

The digital storage oscilloscopes of the NI-ELVIS are dual-beam oscilloscopes with two vertical inputs, as described above. The vertical input on the oscilloscope, instead of driving a vertical amplifier, is digitized by an analog-to-digital (A-to-D) converter to create a data set that is stored in the memory of a microprocessor. The data set is processed and then sent to the display. The data set can be written to a flash drive or sent over a LAN or a WAN for processing or archiving. The screen image can be directly recorded on paper by means of an attached printer or plotter, without the need for an oscilloscope camera. The scope’s own signal analysis software can extract many useful time-domain features (e.g., rise time, pulse width, amplitude), frequency spectra, histograms and statistics, persistence maps, and a large number of parameters meaningful to engineers in specialized fields such as telecommunications, disk drive analysis, and power electronics.

Digital oscilloscopes are limited principally by the performance of the analog input circuitry and the sampling frequency. In general, the sampling frequency should be at least the Nyquist rate – double the frequency of the highest-frequency component of the observed signal – to avoid aliasing.

Avoiding Grounding Errors with Oscilloscope

The shield or ground wire on the oscilloscope’s signal input is connected to the oscilloscope’s chassis ground, and therefore to the ground lead on the instrument’s electrical power connection. This fact creates the possibility of grounding errors when making connections to circuits, especially when trying to measure voltages across ungrounded components.

The problem is illustrated in the following diagram. Suppose one wants to measure the voltage across resistor R1. Because the circuit and the oscilloscope both have the same ground, connecting the oscilloscope’s input leads directly across R1, as indicated, will create a short across R2. Besides giving an incorrect reading, such a connection might damage either the oscilloscope or the circuit under test.

A solution is simply to swap (interchange) the positions of R1 and R2, so that one end of R1 is at ground. Then there is no problem directly connecting the oscilloscope across R1, because both grounds are connected together.
**Experiment #1: Series Circuit DC Voltage Measurements**

1. Analyze the circuit in Figure 1 (Series DC Circuit) to determine V1 and V2 using calculations from basic circuit analysis techniques.

   **Calculated:**  
   \[ V1 = \quad \quad V2 = \quad \quad \]

2. Construct the circuit in Figure 1. Use the variable power supply VPS to set \( V_s \) and then measure V1 and V2 using the DMM.

   **Measured using DMM:**  
   \[ V1 = \quad \quad V2 = \quad \quad \]

3. Use the scope to display \( V_s \) on Channel 0 and V2 on Channel 1. Measure V2 using the scope’s display. Use the \textbf{INTERCHANGE} method described above to swap R1 and R2 and then measure V1 across R1, with R1 in position 2.

   **Measured using Scope:**  
   \[ V1 = \quad \quad V2 = \quad \quad \]

**Experiment #2: Series RC Circuit AC Voltage and Phase Measurements**

1. Construct the circuit in Figure 2. Use the function generator to set \( V_s \) according to previously defined instructions and in Figure 5. Use the AC voltage setting on the DMM to measure \( V_s \), V1 and V2.

   **Measured using DMM:**  
   \[ V1 = \quad \quad V2 = \quad \quad \]

2. Use the scope to display \( V_s \) on Channel 0 and V2 on Channel 1. Measure V2 using the scope’s display. Use the \textbf{INTERCHANGE} method described above to swap R1 and C1 and then measure V1 across R1, with R1 in position 2.

   **Measured using Scope:**  
   \[ V1 = \quad \quad V2 = \quad \quad \]

**Phase Measurements:**

The phase difference between two signals is simply another way of viewing the fact that two signals occur at different times. The difference is phase angle between two waveforms may be measured directly on the oscilloscope with little difficulty.

3. Use the \textbf{INTERCHANGE} method to restore/swap R1 and C1 to their original positions, in preparation for phase measurements.

   Connect the reference voltage to Channel 0 of the oscilloscope and connect the second voltage V2 to Channel 1. Adjust the amplitudes so the overlapping signals look
something like the figure to the right, where the solid curve is Channel 0 (the reference) and the dashed curve is Channel 1. Start the left-most waveform from a positive slope zero-crossing using the Time/Div horizontal position control. Adjust the waveform so that exactly one cycle appears within the ten horizontal divisions on the display. Thus, each division corresponds to $360^\circ/10 = 36^\circ$. The phase shift $\phi$ in degrees can be calculated by the number of divisions separated $\times 36^\circ$, e.g. 2 divisions $\times 36^\circ = 72^\circ$. (In this figure, the dashed curve is lagging the solid curve; if the dashed curve were shifted to the left so it “started” before the solid curve, then the dashed curve would be leading the solid curve.)

Measure the phase of V2 by observing the number of divisions between the positive-slope zero crossings of the V2 waveform and the Vs waveform. Be sure to use the correct sign.

$\angle V2 = \underline{\hspace{2cm}}$

4. Use the **INTERCHANGE** method described above to swap R1 and C1 and then measure the phase of V1 (with R1 in position 2).

$\angle V1 = \underline{\hspace{2cm}}$

**Experiment #3: Series RL Circuit AC Voltage and Phase Measurements**

1. Construct the circuit in Figure 3. Use the function generator to set Vs according to previously defined instructions. Use the AC voltage setting on the DMM to measure Vs, V1 and V2.

   Measured using **DMM**: V1 = ______ V2_____

2. Use the scope to display Vₜ on Channel 0 and V2 on Channel 1. Measure V2 using the scope’s display. Use the **INTERCHANGE** method described above to swap R1 and L1 and then measure V1 across R1, with R1 in position 2.

   Measured using **Scope**: V1 = ______ V2_____

**Phase Measurements:**

3. Use the **INTERCHANGE** method to restoreswap R1 and L1 to their original positions, in preparation for phase measurements. Repeat procedure used in the last experiment to measure the phase angle.
Measure the phase of V2 by observing the number of divisions between the positive-slope zero crossings of the V2 waveform and the Vs waveform. Be sure to use the correct sign.

\[ \angle V2 = \text{______} \]

4. Use the **INTERCHANGE** method described above to swap R1 and L1 and then measure the phase of V1 (with R1 in position 2).

\[ \angle V1 = \text{______} \]

**Analysis:**

1. Compute the relative differences between the measured and calculated values of V1 and V2 in Experiment #1.

2. Compute the relative differences between the measured values in Experiment #2 and calculated values: \( V1 = 2.537 \text{ Vrms}, \ V2 = 2.462 \text{ Vrms}, \ V1 = 7.176 \text{ Vp-p}, \ V2 = 6.964 \text{ Vp-p}, \ \angle V1 = 44.14^\circ \) and \( \angle V2 = -45.86^\circ \).

**Report Guidelines and Post Lab Procedures:**

Compare your experimental (measured) results to your theoretically (calculated) expected values using relative difference calculations. Tabulate your relative differences to compare the measured values of all V’s to the ones you determined in your pre-lab calculations. Interpret your results, identifying sources of error as appropriate. Remember to include the following in your lab report: Calculations from the pre-lab, PSpice simulation of the circuit displaying voltages, and measurements acquired during lab.
Lab Exercise 9: Transient RC Circuits

Overview and Introduction:
1. Use the NI Elvis Function Generator to produce a square-wave voltage for AC circuits.

2. Use the NI Elvis Oscilloscope to measure the amplitude and phase of sinusoidal signals for AC circuit analysis.

Equipment:
NI ELVIS II workstation, computer with NI Elvis II interface software installed including the NI Elvis Oscilloscope and Function Generator, PSpice installed, Digital Multimeter and test probes, protoboard, banana plug cables, assorted resistors, and jumper wire.

Pre-Lab Assignment:
1. Use the schematic editor of PSpice to layout the circuits in Figures 1-2 using the following PSpice procedure:
   a. Layout circuit with VPULSE source.
   b. V1=0 (Low Voltage), V2=10 (High Voltage), TD=0 (Time Delay), TR=TF=0.00001ms (Rise and Fall Times), For a symmetrical 1kHz wave PW=0.5ms (High Period of Wave), PER=1ms (Period of Wave 1kHz).
   c. Place V probe before and after resistor (Or when capacitor and resistor are switched just so that you will measure Vs and the voltage between the two components).
   d. On the menu bar Analysis → Setup → (Check and click) Transient .
   e. Set Print Step to 100us and Final Time to 2ms.

   Select “Simulate”. Add a text box containing your name in the upper right corner, the Lab # and the date, prior to saving into a SINGLE pdf file as a part of your pre-lab. Be sure to record your values.

2. Construct the two circuits so that you will be ready to test and analyze while in the laboratory in Figures 1-2, using the values below:

   \[ R1 = 1.5 \, k\Omega \]
   \[ R2 = 10 \, k\Omega \]
   \[ C1 = 0.082 \, \mu F \]
   \[ V_{s}(AC) = \text{Square-wave, 0-10 V}_{\text{p-p}} @ 1 \, \text{kHz} \]
**Lab Procedures:**

The function generator settings should be set to supply a 10 V\(_{\text{p-p}}\) square-wave with the following:

- Signal Route: **FGEN BNC**
- Waveform setting: **Square-wave**
- Frequency: **1 kHz**
- Amplitude: **10 V\(_{\text{p-p}}\)**

**Procedure I – RC Circuit with Short Time Constant**

1. Construct the circuit in Figure 1. Use the oscilloscope to measure \(V_s\) on Channel 0 and \(V_C\) on Channel 1. Record the value of \(V_C\) at each of the time intervals in Table 1.

2. Reverse the position of the capacitor and the resistor. Use the oscilloscope to measure \(V_s\) on Channel 0 and \(V_R\) on Channel 1. Record the value of \(V_R\) at each of the time intervals in Table 1.
3. Use PSpice to generate plots of the three parameters: $V_C(t)$, $V_R(t)$ and $i_C(t)$. Voltage plots should appear as shown in Figures 3 and 4 for the two different positions. Not shown is the capacitor current $i_C(t)$ plot.

4. Complete Table 1 by calculating the values of $i_C(t)$ using:

   Rise Cycle: \[ i_C(t) = I_o \left( e^{-t/\tau} \right) \]

   Fall Cycle: \[ i_C(t) = I_o \left( 1 - e^{-t/\tau} \right) \]

5. What is the time constant $\tau$ for this circuit?

Table 1. Voltages and Current at 100 $\mu$s Time Intervals

<table>
<thead>
<tr>
<th></th>
<th>0 $\mu$s</th>
<th>100 $\mu$s</th>
<th>200 $\mu$s</th>
<th>300 $\mu$s</th>
<th>400 $\mu$s</th>
<th>500 $\mu$s</th>
<th>600 $\mu$s</th>
<th>700 $\mu$s</th>
<th>800 $\mu$s</th>
<th>900 $\mu$s</th>
<th>1 ms</th>
</tr>
</thead>
<tbody>
<tr>
<td>$V_C(t)$</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$V_R(t)$</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$i_C(t)$</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 3. PSpice Simulated Capacitor Voltage Waveform
Procedure II – RC Circuit with Long Time Constant

1. Construct the circuit in Figure 2. Use the oscilloscope to measure $V_s$ on Channel 0 and $V_C$ on Channel 1. Record the value of $V_C$ at each of the time intervals in Table 2.

2. Reverse the position of the capacitor and the resistor. Use the oscilloscope to measure $V_s$ on Channel 0 and $V_R$ on Channel 1. Record the value of $V_R$ at each of the time intervals in Table 2.

3. Use PSpice to generate plots of the three parameters: $V_C(t)$, $V_R(t)$ and $i_C(t)$. Voltage plots should appear as shown in Figures 5 and 6 for the two different positions. Not shown is the capacitor current $i_C(t)$ plot.

4. Complete Table 2 by calculating the values of $i_C(t)$ using:

   \[ i_c(t) = I_o \left( e^{-t/\tau} \right) \]

   \[ i_c(t) = I_o \left( 1 - e^{-t/\tau} \right) \]

5. What is the time constant $\tau$ for this circuit?
Table 2. Voltages and Current at 100 μs Time Intervals

<table>
<thead>
<tr>
<th></th>
<th>0 μs</th>
<th>100 μs</th>
<th>200 μs</th>
<th>300 μs</th>
<th>400 μs</th>
<th>500 μs</th>
<th>600 μs</th>
<th>700 μs</th>
<th>800 μs</th>
<th>900 μs</th>
<th>1 ms</th>
</tr>
</thead>
<tbody>
<tr>
<td>$V_C(t)$</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$V_R(t)$</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$i_C(t)$</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 5. PSpice Simulated Capacitor Voltage Waveform
Figure 6. PSpice Simulated Resistor Voltage Waveform for Position 2

Report Guidelines and Post Lab Procedures:

Compare your experimental (measured) results to your simulated values. Interpret your results, identifying sources of error as appropriate. Remember to include the following in your lab report: Calculations, PSpice simulations and measurements acquired during lab.
Lab Exercise 10: Phasors and Impedances

Overview and Introduction:
A sinusoidal current or voltage at a given frequency is characterized by only two parameters, an amplitude and a phase angle. The complex representation of the voltage or current is usually written in polar form and is characterized by these same two parameters. This complex representation is called a phasor. The power of the phasor-based analysis technique is that algebra can be used solve RLC AC circuits.

Equipment:
NI ELVIS II workstation, computer with NI Elvis II interface software installed including the NI Elvis Oscilloscope and Function Generator, PSpice installed, Digital Multimeter and test probes, protoboard, banana plug cables, assorted resistors, and jumper wire.

Pre-Lab Assignment:
1. Use the schematic editor of PSpice to layout the circuit in Figure 2 using the PSpice procedure with settings as follows:
   a. Use VSIN (DC = 0, AC = 0.707, VOFF = 0, VAMPL = 1, FREQ = 400 (first, than 2K, 10K), PHASE = 0.
   b. Analysis/Setup/Transient - Print Step = 0ns, Final Time = 5.5ms.

2. Select “Simulate”. Results should appear as shown in Figures 3 - 5 showing both voltage amplitudes and phase angles at the three different frequencies. Add a text box containing your name in the upper right corner, the Lab # and the date, prior to saving into a SINGLE pdf file as a part of your pre-lab.

3. For the circuit shown in Figure 1, calculate the impedance of each circuit element at the three different frequencies and complete Table 1. The phase angle of the source voltage is 0° and the frequency of the source is 400 Hz, than 2.0 kHz, and 10 kHz.

\[
Z_R = R \\
Z_L = j\omega L \\
Z_C = \frac{-j}{\omega C} \\
\omega = 2\pi f = \frac{2\pi}{T}
\]

Table 1. Impedances

<table>
<thead>
<tr>
<th>Frequency</th>
<th>(Z_R)</th>
<th>(Z_L)</th>
<th>(Z_C)</th>
</tr>
</thead>
<tbody>
<tr>
<td>400 Hz</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2.0 kHz</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10.0 kHz</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
4. Construct the circuit in Figure 1 using the values below so that you will be ready to test and analyze while in the laboratory:

- **R1** = 1 kΩ
- **L1** = 68 mH
- **C1** = 0.082 µF
- **Vs** (sinusoidal wave) = 2 Vp-p @ 400 Hz, 2.0 kHz, and 10.0 kHz

![Figure 1. Schematic of the Sinusoidal Series RLC Circuit](image)

```plaintext
+ V_R -
R1
+ 1k -
2 V_{pp}
+ 400Hz
+ 2.0kHz
+ 10kHz -
Vs
+ 0.082uF -
C1
+ V_C -
68mH
+ V_L -
L1
```
Figure 2. PSpice Simulation Layout of the Sinusoidal Series RLC Circuit
Figure 3. Simulation Results of the Sinusoidal Series RLC Circuit showing Voltage Amplitudes and Phase Angles at 400 Hz
Figure 4. Simulation Results of the Sinusoidal Series RLC Circuit showing Voltage Amplitudes and Phase Angles at 2.0 kHz
Lab Procedures:

The function generator settings should be set to supply a 2 Vp-p sine-wave with the following:

- Signal Route: FGEN BNC
- Waveform setting: Sine-wave
- Frequency: 400 Hz/2.0 kHz/10 kHz
- Amplitude: 2 Vp-p

1. Construct the circuit in Figure 1. Use the oscilloscope to measure the amplitude of $V_s$ ($V_p$) on Channel 0 and the amplitudes ($V_p$) and phase angles of all the other circuit element voltages (resistor, capacitor, and inductor) on Channel 1. **Remember to reconfigure the circuit elements so that Channel 1 will always measure the voltage using ground as the reference.** Record the values of each element, at each frequency in Table 2.
2. Repeat Step 1 for frequencies of 2 kHz and 10 kHz.

3. Determine the phasor source current $I_S$ in polar form using $V_R$ and $R$, for each frequency. Update the results in Table 3.

4. Using the measured values in Table 2 and the values of $I_S$ in Table 3, calculate the impedances and complete Table 3.

5. The circuit impedance $Z_{eq}$ is $V_s/I_s$. Calculate $Z_{eq}$ and complete Table 3.

6. **Plot the phasor diagram of the voltages** at each of the three frequencies and include the results in the laboratory report.

Table 2. Oscilloscope measured phasor voltages (Amplitude - $V_P$ and Phase Angle $\angle^\circ$)

<table>
<thead>
<tr>
<th>Frequency</th>
<th>$V_S$</th>
<th>$V_R$</th>
<th>$V_L$</th>
<th>$V_C$</th>
</tr>
</thead>
<tbody>
<tr>
<td>400 Hz</td>
<td>$0^\circ$</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2.0 kHz</td>
<td>$0^\circ$</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10.0 kHz</td>
<td>$0^\circ$</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table 3. Tabulated Results

<table>
<thead>
<tr>
<th>Frequency</th>
<th>$I_S$</th>
<th>$Z_{eq}$</th>
<th>$Z_R$</th>
<th>$Z_L$</th>
<th>$Z_C$</th>
</tr>
</thead>
<tbody>
<tr>
<td>400 Hz</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2.0 kHz</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10.0 kHz</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Report Guidelines and Post Lab Procedures:**

Compare your calculated (theoretical), and experimental (measured) results to your simulated values. Interpret your results, identifying sources of error as appropriate. Remember to include the following in your lab report: Calculations, PSpice simulations and measurements acquired during lab.
Lab Exercise 11: Source-Free RL and RC Circuits

Overview and Introduction:
Most electrical circuits have some type of time-dependent behavior. The term time domain analysis indicates that we will be determining the output variables as a function of time. In PSpice, time domain analysis is referred to as transient analysis. The response of a circuit driven by a time-varying source is referred to as the forced response of the circuit, and the voltage source is the forcing function. Time-varying circuits that contain no sources produce what is referred to as the natural response of the circuit. Source free circuits must have an initial voltage on the capacitor or an initial current flowing in an inductor for a time dependent response to occur.

Equipment:
Computer with PSpice installed.

Lab Procedures:
1. Determine the natural response of a simple RL circuit shown in Figure 1, using the schematic editor of SPspice to layout the circuit. Set R = 1 kΩ and L = 10 mH with an initial inductor current IC = 10 mA (part attribute initial condition IC). In the transient analysis, specify the Final Time = 50 μs. Select “Simulate”.
   a. Plot the inductor current.
   b. Determine the time at which the current has reached ½ of its original value, using the Probe Cursor in PSpice.
   c. What is the time constant τ for this circuit?
   d. How many time constants does it take for the current to reach 38% of its initial value?

2. Determine the natural response of a simple RC circuit shown in Figure 2, using the schematic editor of SPspice to layout the circuit. Set R = 5 kΩ and C = 10 μF with an initial capacitor voltage of IC = 5V (part attribute initial condition IC). The switch (SW_tCLose) closes at t = 10 ms (TCLOSE=10M, TTRAN=10ps, ROPEN=100Meg, RCLOSED=0.001). In the transient analysis, specify the Final Time = 250 ms. Select “Simulate”.
   a. Plot the voltage across the capacitor.
   b. Plot the current through the resistor.
   c. Determine the maximum value of the capacitor voltage.
   d. Determine the length time for which this maximum voltage stays constant.
e. What is the time constant $\tau$ for this circuit?

f. How many time constants does it take for the voltage to reach 0% of its initial value?

g. What is the maximum value of the current through the resistor? (If you get a negative value $I(R)$, rotate your resistor in PSpice.)

Figure 1. PSpice Simulation Layout of the Source-free RL Circuit with Initial conditions and Current Sensing

Figure 2. PSpice Simulation Layout of the Source-free RC Circuit with Switch closing at $t = 10$ ms to drain the Capacitor

Report Guidelines and Post Lab Procedures:

Interpret and report your simulated results with a detailed discussion of the theory behind the results. Remember to include the following in your lab report: PSpice simulation results.
Lab Exercise 12: Sinusoidal RLC Circuits

Overview and Introduction:
Most practical circuits have some form of time-varying source in the circuit. In simple cases, time-varying sources are modeled using switches. More complex time varying sources require models that follow certain mathematical behavior. Voltage source VPULSE is one of the simplest time-varying voltage supply models. This voltage source delivers a pulse waveform which is defined by a set of parameters that control transition times and voltage levels. The step response of a circuit is its behavior when the voltage or current excitation is applied in the form of a step function. The ideal step function has an infinitely small rise time.

Equipment:
Computer with PSpice installed.

Lab Procedures:
1. Determine the behavior of the current flowing in the inductor and the voltage across the capacitor in the RLC circuit shown in Figure 1, using the schematic editor of PSpice to layout the circuit. Set R1 = 20 Ω, R2 = 20 Ω, C1 = 8 mF, and L1 = 20 H with an initial inductor current IC = 4A (part attribute initial condition IC), and the initial capacitor voltage of IC = 15V (part attribute initial condition IC). The switch (SW tCLose) closes at t = 0 s. VPULSE source emulates the behavior of the step function voltage source 30u(-t) by having an initial voltage of 30 V for t < 0 and changing to 0 at t = 0. The rise time for VPULSE is set to 1 nanosecond to model a sharply falling pulse as defined by the u(-t) function. In the transient analysis, specify the Final Time = 5 s. Select “Simulate”.
   a. Plot the voltage across the capacitor.
   b. Plot the current through the inductor.
   c. Determine the maximum value of the inductor current.
   d. Determine the minimum value of the capacitor voltage and the time this minimum was reached.
   e. Calculate the capacitor voltage and inductor current for this circuit at time intervals of t = 0, 1, 2, 3, 4, and 5 seconds using the following equations:

\[
\begin{align*}
I_L &= 4 + 0.063(e^{-1.915t} - e^{-0.0833t}) \\
V_C &= 15.7e^{-0.0833t} - 0.683e^{1.915t}
\end{align*}
\]
Figure 1. PSpice Simulation Layout of the RLC Circuit with a Step Input and a Switched Current Source

Report Guidelines and Post Lab Procedures:

Interpret and report your simulated results with a detailed discussion of the theory behind the results. Remember to include the following in your lab report: PSpice simulation results.
LABORATORY EXERCISE 6

Analysis, Simulation and Measurement of A Multi-node Circuit

From: Student

To: Instructor

For: Date

Southern Polytechnic State University

DIVISION OF ENGINEERING
ELECTRICAL ENGINEERING
TABLE OF CONTENTS

Contents

TABLE OF CONTENTS ................................................................................................. 2
DESCRIPTION .............................................................................................................. 3
PRE-LAB ASSIGNMENT ........................................................................................ 4
CALCULATIONS ...................................................................................................... 6
MEASUREMENTS .................................................................................................... 7
CONCLUSION .......................................................................................................... 9
DESCRIPTION

Our goal of this lab is to find the voltages and currents in a multi-node circuit. In order to do so, we apply Nodal and Mesh Analysis learned in the classroom. The circuit in this lab is a combination of parallel and series resistors, which may seem complex at first. Using Nodal and Mesh Analysis, the circuit can be broken down into more manageable parts. The circuit contains eight basic components:

1. Six resistors
2. A single DC power supply (includes ground)
3. Wires used to connect the components

There are several tools needed to find and calculate the voltages and currents within the circuit.

They are as follows:

1. A multimeter or NI Elvis II. Note that the NI Elvis II is preferable for this lab due to the small values of amperes we will be measuring.
2. A TI-89 or MathLab to calculate the matrices
PRE-LAB ASSIGNMENT

We first want to find the voltages and currents mathematically. This gives us a foundation and is essential to see if our measurements are correct in the lab environment. Our circuit is built as seen in Figure 1 below:

![Fig. 1 (above)](image1)

We want to find V1, V2, V3, I1, I2, and I3 as seen in Figure 2 below:

![Fig. 2 (above, borrowed from lab manual)](image2)
Let’s first start by making sure our resistors match the circuit. We know this by using the color band on the resistors.

For Resistor 1, we have:

Brown Green Red, which gives us 1 | 5 | 100, where the third digit is a multiplier for the first two digits. This gives us: 15 * 100, or 1,500 Ohms.

Using the same method, we find the resistance for the other resistors:

R1: Brown Green Brown: 1500 Ohms (calculated above)

R2: Grey Red Brown: 8 | 2 | x 10 = 820 Ohms

R3: Red Red Brown: 2 | 2 | x 10 = 220 Ohms

R4: Brown Black Orange: 1 | 0 | x 1000 = 10000 Ohms

R5: Green Blue Brown: 5 |62 | x 10 = 560 Ohms

R6: Brown Black Red: 1 |0 | x 100 = 1000 Ohms

All the resistors match the circuit we are trying to build.

Next, we use PSpice to find all values for V and I. This will provide a baseline to ensure our math is correct. We see the circuit in PSpice in Figure 3 below:

Fig. 3 (above)
CALCULATIONS

Now it is time to use Nodal and Mesh Analysis. For I1, we find that:

\[-8V + (I1 - I3)820 + (I1 - I2)10k + (I1)1k = 0 \_\]
\[-8V + 820I1 - 820I3 + 10kI1 - 10kI2 + 1kI1 = 0 \_\]
\[-8V + 11,820I1 - 820I3 + 10KI2 = 0\]

For I2, we find that:

\[(I2 - I3)220 + 560I2 + (I2 - I1)10k = 0 \_\]
\[220I2 - 220I3 + 560I2 + 10kI2 - 10kI1 = 0 \_\]
\[10,780I2 - 10kI1 - 220I3 = 0\]

For I3, we find that:

\[1500I3 + (I3 - I2)220 + (I3 - I1)820 = 0 \_\]
\[1500I3 + 220I3 - 220I2 + 820I3 - 820I1 = 0 \_\]
\[2540I3 - 220I2 - 820I1 = 0\]

Using a matrix in the TI-89, we find the following currents:

\[I1 = 3.76 \text{ mA}\]
\[I2 = 3.52 \text{ mA}\]
\[I3 = 1.52 \text{ mA}\]

Using the voltage drop across the appropriate resistors, we find the following voltages:

\[V1 = 8 - (820)(2.239\text{mA}) = 6.164\text{V}\]
\[V2 = 6.164 - (220)(1.99\text{mA}) = 5.73\text{V}\]
\[V3 = 8 - (1000)(3.75\text{mA}) = 3.76\text{V}\]
MEASUREMENTS

There are two types of measurements in this lab, the first is voltage and the second is current. For measuring voltage, place the red lead of the Digital Multimeter (DMM) at the positive side of the component (voltage source or resistor), and the black lead of the DMM on the ground side of the component. Be sure to use passive sign convention in order to know which side is positive and which is negative. For measuring current, disconnect the components positive lead, and connect it to the black lead of the DMM. Connect the red lead of the DMM to the supply source the component was connected to. Be sure the circuit is not on when disconnecting the component.

The goal for measuring voltage is seeing the voltage potential, which is why we place leads on opposite sides of the component. The goal for measuring current is placing our DMM in series with the circuit, which allows us to measure the current flowing in the circuit when the circuit is live.

Using the above method, we measured the following voltages and currents:

V1 = 6.25 V
V2 = 5.8 V
V3 = 3.8 V
I1 = 3.77mA
I2 = 3.54mA
I3 = 1.51mA
Using the following formula to check our percentage of error: 

\[
\left( \frac{\text{Expected} - \text{Measured}}{\text{Expected}} \right) \times 100
\]

we find that:

For V1: 1.4% error
For V2: 1.2% error
For V3: 1.1% error
For I1: 0.26% error
For I2: 0.57% error
For I3: 0.66% error

All calculations and measurements are well within the range of accuracy given testing conditions and component variance.

CONCLUSION

We first calculated the expected voltage and current values, and the confirmed the calculations by examining the circuits we built in lab. Both numbers came within tolerable differences. Using tools like Ohms Law, Kirchhoff's Laws, and nodal and mesh analysis, we can understand the circuits we build before we build them, and confirm the results after we build them. Although we cannot always see electricity by the eye, we can always see it on paper through our math.
# Appendix B - Resistor Color Code Chart

<table>
<thead>
<tr>
<th>COLOR</th>
<th>1st BAND</th>
<th>2nd BAND</th>
<th>3rd BAND</th>
<th>MULTIPLIER</th>
<th>TOLERANCE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1Ω</td>
<td>± 1% (F)</td>
</tr>
<tr>
<td>Brown</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>10Ω</td>
<td>± 2% (G)</td>
</tr>
<tr>
<td>Red</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>100Ω</td>
<td>± 0.5% (D)</td>
</tr>
<tr>
<td>Orange</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>1KΩ</td>
<td>± 0.25% (C)</td>
</tr>
<tr>
<td>Yellow</td>
<td>4</td>
<td>4</td>
<td>4</td>
<td>10KΩ</td>
<td>± 0.10% (B)</td>
</tr>
<tr>
<td>Green</td>
<td>5</td>
<td>5</td>
<td>5</td>
<td>100KΩ</td>
<td>± 0.05%</td>
</tr>
<tr>
<td>Blue</td>
<td>6</td>
<td>6</td>
<td>6</td>
<td>1MΩ</td>
<td>± 1% (J)</td>
</tr>
<tr>
<td>Violet</td>
<td>7</td>
<td>7</td>
<td>7</td>
<td>10MΩ</td>
<td>± 10% (K)</td>
</tr>
<tr>
<td>Grey</td>
<td>8</td>
<td>8</td>
<td>8</td>
<td>237Ω</td>
<td>± 1%</td>
</tr>
<tr>
<td>White</td>
<td>9</td>
<td>9</td>
<td>9</td>
<td>0.1</td>
<td>± 5%</td>
</tr>
<tr>
<td>Gold</td>
<td></td>
<td></td>
<td></td>
<td>0.01</td>
<td>± 10%</td>
</tr>
<tr>
<td>Silver</td>
<td></td>
<td></td>
<td></td>
<td>0.1%</td>
<td>0.25%</td>
</tr>
</tbody>
</table>

4-Band-Code: 2%, 5%, 10%

5-Band-Code: 0.1%, 0.25%, 0.5%, 1%